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OMG! Not again!

In the U.S., Daylight Savings Time is “starting”
again. As in, “spring forward.” That means we
all advance our clocks by one hour. Bleh! I’m
reminded of the supposed old American Indian
quote (no one really knows if it is, but it makes
the point perfectly): “Only white man thinks
that cutting one foot from top of blanket and
sewing to bottom of blanket makes blanket one
foot longer.”

I’m sure this insanity is also happening in other
parts of the world.

This year, the U.S.’s observance of the annual
time dance fiasco starts at 2 a.m. on March 12,
2023. Residents of the U.K. complete their
annual time dance fiasco two weeks later, on
March 26, 2023.

In case you can’t tell, I ***hate*** the whole
messing-with-the-clocks insanity.

Time, at least in the way that we refer to it, is a
manmade construct. We’ve set it up to help
explain night from day, to mark the passage of
time during our lifespan, to help establish some
order to our existence, and is precisely tailored
to (and ruled by) the diurnal behavior of the
only home world we have. Oh, it has other
attributes, too. This list could go on for a long
time, but you get the idea. Entire series of books

have been written trying to explain our concept
of time.

I’m more of the mind that if you want more
hours of daylight, get up and get started on the
day’s activities earlier. Most animals rule their
lives by hours of daylight. They get up and “do
their thing” when the sun goes up (or down) and

bed down to rest when the sun goes down (or
up). The “confusion” there depends on whether
the animal is nocturnal, or if it goes about its
activities during the daylight. We are the only
fools of the animal kingdom that think we can
come up with a better way of defining our
existence than that from Mother Nature herself.

And, it’s not as though we “create” additional
hours of daylight. Rather, we temporarily
reassign different values to them. No matter
how we mark them, there are still the same
number of hours of daylight in any given day.

A year or two ago, in the U.S., the U.S. Senate
passed a bipartisan bill to permanently move us
to year-round Daylight Savings Time, where we
stay on the advanced hours year round and do
away with the end of Daylight Savings Time in
the fall. There would be no more “falling back”
in November, as it is now.

The last I had heard was that although passing
through the U.S. Senate, the bill never passed
through the U.S. House of Representatives, and
cannot be enacted unless or until it is approved
by both chambers of Congress.

Phew! Narrowly dodged that one!

I’m a proponent of just doing away with the
whole Daylight Savings Time mess, and
keeping us on regular time all year. With one
move, we can eliminate all of the stress

From The Chief Editor's Desk
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associated with the biannual dance with our
clocks. The “stress” induced is well
documented, even among prestigious scientific
outlets. Perform your own search for “stress of
daylight savings time.”

And stress is one thing we’d all like to lessen its
impact on our lives. We sure don’t need to add
to it, and if we can eliminate some of it, then
even better. Here’s our chance to set things
right, and to lessen stress at the same time.

********************

This month’s cover image is by
Monoar_CGI_Artist, on Pixabay.

********************

Until next month, I bid you peace, happiness,
serenity and prosperity … and continued good
health!

Screenshot ShowcaseScreenshot Showcase

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

From The Chief Editor's Desk

Posted by tuxlink, on February 2, 2023, running KDE.

http://www.pclosusers.com/services-signup.php
https://pclosmag.com/searchpclosmag.html
http://www.dosgamesarchive.com/
https://www.businessinsider.com/daylight-saving-time-is-deadly-2018-3?op=1
https://www.health.harvard.edu/staying-healthy/the-dark-side-of-daylight-saving-time
https://pixabay.com/photos/clock-alarm-clock-watch-time-old-1274699/
https://pixabay.com/users/monoar_cgi_artist-2240009/
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by Paul Arnote (parnote)

I’m going to try something a little different this
month. To be perfectly honest, the monthly
Short Topix column is very time consuming to
write (as in DAYS, not hours), and sometimes
(often) quite difficult to write. I collect “things”
that I think might be of interest to a wide variety
of PCLinuxOS users all month long, and that
part isn’t changing.

PCLinuxOS users have a wide variety of
interests, and it’s important to keep ourselves
informed about what’s going on beyond the
borders of our beloved PCLinuxOS playground.
Sometimes, it’s even good to reach out beyond
our normal interests and comfort zone. It’s how
we discover “new things” that we like. A
“roundup” article, therefore, is still warranted
(in my humble opinion). So, to mark the
“change,” we’re going to change the name of
Short Topix to ICYMI (in case you missed it).
The entries will be shorter, with the same links
you’ve become accustomed to in the Short
Topix column, and you can follow the links to
read more about the topics that interest you.

This will be more of a “roundup” type of article.
Gone will be the subdivisions that have been a
part of the former Short Topix column. Instead,
I’ ll be presenting items in the order in which I
“find” them. This should also lend itself to
having an even greater range of topics. Instead

of me wondering how I’m going to write up the
assorted sections of the previous Short Topix
article (which resulted in some items never
being mentioned, for a myriad of reasons),
there’ ll just be a short “blurb” about each item
to give you the gist of what each “topic” is
about.

Hopefully, this will make the column easier to
write every month, plus give you – the readers –
a wider variety of topics. Prior to this change,
and since I’m being honest about it all, I was
considering doing away with the Short Topix
column. I just didn’t have the time or resources
to continue Short Topix in its current format.
However, this change will/should allow us to
maintain that monthly “happenings” column,
hopefully without the strain that Short Topix
placed upon me. So, let’s try it “this” way for a
while.

Now … let’s see what you might have missed
…

Your Gmail account will soon look a little bit
different as the company finally rolls out its
long-expected makeover to all users, according
to an article on TechRadar.

Astronomers have discovered 12 new moons
around Jupiter, putting the total count at a
record-breaking 92, according to an article on
Yahoo! News. That's more than any other planet
in our solar system. Saturn, the one-time leader,
comes in a close second with 83 confirmed
moons.

Royal Ransomware is the latest ransomware
operation to add support for encrypting
Linux devices to its most recent malware
variants, specifically targeting VMware ESXi
virtual machines, according to an article on
BleepingComputer.

New research from Check Point Research
exposes a crypter that stayed undetected for

Linux Docs
Linux Man Pages

ICYMI: Ransomware Operation
Adds Support For Linux Devices

http://www.die.net/
https://www.techradar.com/news/your-gmail-is-permanently-changing-soon-heres-what-to-expect
https://news.yahoo.com/jupiters-moon-count-jumps-92-210813008.html
https://www.bleepingcomputer.com/news/security/linux-version-of-royal-ransomware-targets-vmware-esxi-servers/
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six years and is responsible for several major
malware infections around the globe, according
to an article on TechRepublic.

A new attack campaign launched by an
unknown threat actor targets the U.S. with
two malware families: MortalKombat
ransomware and Laplas Clipper, according to
an article on TechRepublic. The campaign is
aimed at Windows users.

Helsinki-based security firm WithSecure has
unearthed a kudzu-like network of
fraudulent content aimed at getting people to
invest in fake cryptocurrency investments,
according to an article on TechRepublic.

Cybersecurity experts at Minerva recently made
a stunning discovery of a new malware tagged
Beep that has the features to evade detection
and analysis by security software, according
to an article on TechRepublic. The cybersecurity
organization discovered Beep after samples
were uploaded on VirusTotal.

Fears have been growing that the U.S. and the
world could be hit by a recession this year, and
with a slower economy comes the prospect of
job cuts. If layoffs are in store, however, a new
report from cybersecurity industry
association (ISC)² says that security
professionals will be among the least affected,
according to an article on TechRepublic.

Two newly discovered forms of frozen salt
water could help scientists resolve a mystery

concerning the Solar System's ice-encrusted
moons, according to an article on ScienceAlert.

Freiburg researchers demonstrate that the
transport of molecules along the cell’s
skeleton plays a crucial role in cancer
metastasis, according to an article on
SciTechDaily.

For the first time, researchers at the
University of California San Diego have
created an atomic-level computer model of
the H1N1 virus that reveals new
vulnerabilities through glycoprotein
“breathing” and “tilting” movements,
according to an article on SciTechDaily. This
work, published in ACS Central Science,
suggests possible strategies for the design of
future vaccines and antivirals against influenza.

Google Chrome [has] always had a big problem
with memory usage. [Google] is finally
addressing the issue in a new Chrome 110
update that promises to reduce RAM usage
by up to 30% and make the browser more
efficient, according to an article on
digitaltrends. Check out this article from ZDNet
for directions on how to ensure these settings
are turned on for you in Chrome 110.

The plethora of hidden features buried within
Android phones are part of what makes these
devices some of the best phones around. From
simple hacks to help save you time, through
to powerful developer tools, there are plenty
of ways to get your Android phone to give
you more, according to an article from Tom’s
Guide.

Heinz has launched a search for Elvis Francois,
a man who survived on nothing but ketchup
and spices while he was drifting at sea for 24
days, according to an article on The
Independent.

Mars rovers tasked with hunting for traces of
biology could roll over microscopic life forms
without smelling a thing, simply because their
instruments aren't up to the task. A new study
carried out in Earth's oldest desert shows how
current technology can't always spot the
signatures of life on our own planet's surface.
Let alone on Mars's, according to an article on
Science Alert.

The networking subsystem feature updates
for the Linux 6.3 kernel were submitted that

ICYMI: Ransomware Operation Adds Support For Linux Devices

https://www.techrepublic.com/article/trickgate-crypter-discovered/
https://www.techrepublic.com/article/cryptocurrency-users-ransomware-malware/
https://www.techrepublic.com/article/crypto-scammers-phishing-youtube/
https://www.techrepublic.com/article/beep-malware-evades-detection/
https://www.techrepublic.com/article/cybersecurity-impacted-layoffs/
https://www.sciencealert.com/discovery-of-two-new-forms-of-salt-water-could-rewrite-fundamental-chemistry
https://scitechdaily.com/actin-a-protein-that-helps-drive-cancer-metastasis/
https://scitechdaily.com/a-universal-vaccine-new-computer-model-of-flu-virus-shows-promise/
https://www.digitaltrends.com/computing/chrome-110-heralds-new-memory-efficiency-and-low-power-modes/
https://www.zdnet.com/article/cant-find-google-chromes-new-battery-and-memory-saver-features-do-this/
https://www.tomsguide.com/how-to/hidden-android-features-you-really-need-to-be-using
https://www.independent.co.uk/news/world/americas/heinz-ketchup-elvis-francois-dominica-b2287299.html
https://www.sciencealert.com/there-might-be-a-simple-reason-we-havent-found-life-on-mars
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feature not only some prominent networking
driver enhancements and new wired/wireless
hardware support but also core networking
improvements like BIG TCP for IPv4,
according to an article on Phoronix.

Linus Torvalds reacts to poorly-executed pull
requests for Linux 6.3, according to an article
on It’s FOSS.

Meanwhile, Linus Torvalds, the creator of
Linux, released the latest milestone with the
Linux 6.2 kernel, according to an article on
SDX Central. A big part of the new Linux kernel
is a long list of networking-related updates that
will serve as a foundation for the next
generation of networking and telco equipment.

Researchers publishing in Age and Ageing
have found that, rather than being protective,
an increase in dietary protein is associated
with an increased chance of sarcopenia,
according to an article on lifespan.io.

An ongoing malware campaign targets
YouTube and Facebook users, infecting their
computers with a new information stealer that
will hijack their social media accounts and use
their devices to mine for cryptocurrency,
according to an article on BleepingComputer.

People who regularly use laxatives, a
common treatment for constipation, may
have more than a 50% increased risk of
developing dementia than people who do not
use laxatives, according to a study published in
the February 22, 2023, online issue of
Neurology®, the medical journal of the
American Academy of Neurology, according to
an article on the Science Blog website.

By 2025, nearly half of cybersecurity leaders
will change jobs, 25% for different roles
entirely due to multiple work-related stressors,
according to Gartner, Inc. in a press release on
the Gartner website.

Research into the disease [Alzheimer’s] has
focused on plaques in the brain. But some
scientists think viruses and bacteria play a
role – and their work is gaining ground,
according to an article on The Guardian.

For the first time, research conducted by
Associate Professor Duc Dong, Ph.D. has
revealed that the detrimental effects of Alagille
syndrome, a genetic disorder that has no
cure, can be reversed using a single drug,
according to an article on SciTechDaily.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

ICYMI: Ransomware Operation Adds Support For Linux Devices

https://www.phoronix.com/news/Linux-6.3-Networking-BIG-TCP
https://news.itsfoss.com/linus-torvalds-pull-request/
https://www.sdxcentral.com/articles/analysis/linux-6-2-brings-network-related-updates-adds-800-gbps-and-wifi-7-support/2023/02/
https://www.lifespan.io/news/high-protein-intake-associated-with-sarcopenia/
https://www.bleepingcomputer.com/news/security/new-s1deload-stealer-malware-hijacks-youtube-facebook-accounts/
https://scienceblog.com/536657/oh-sh-people-who-regularly-use-laxatives-may-have-an-increased-dementia-risk/
https://www.gartner.com/en/newsroom/press-releases/2023-02-22-gartner-predicts-nearly-half-of-cybersecurity-leaders-will-change-jobs-by-2025
https://www.theguardian.com/society/2023/feb/19/could-alzheimers-be-caused-by-an-infection
https://scitechdaily.com/reversed-with-a-single-drug-incurable-liver-disease-may-be-curable/
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Yield: 6 to 8 servings

INGREDIENTS

1 tbsp unsalted butter, softened
Olive oil
1 small onion, finely chopped
1 tsp chopped fresh thyme
1 tsp Black Garlic Salt *
½ tsp freshly ground Peppercorns
1 cup heavy cream
1/4 cup mascarpone
3/4 cup (6 oz) shredded Gruyère cheese
2 ½ lbs (about 6) Yukon Gold potatoes, preferably
uniform in size

DIRECTIONS:

Preheat the oven to 400 F with the rack positioned in the
center. Butter a 9-inch baking dish and place on a rimmed
baking sheet, set aside.

In a large skillet over medium heat, warm about 1
tablespoon of olive oil. Add the onion, thyme, black garlic
salt and pepper; sauté with a wooden spoon until the
onions are softened, about 5 minutes. Stir in the heavy
cream and simmer until slightly reduced, about 5 to 8
minutes. While continuing to stir, fold in the mascarpone

and grated cheese until well combined and the cheese is
melted. Set aside to prepare the potatoes.

Scrub the potatoes with a vegetable brush and thinly slice
each potato using a Mandoline, about 1/8-inch thick.

Stir the cream mixture and pour half into the prepared
baking dish. Arrange potatoes in a slight overlapping
pattern. Depending on the size and shape of your baking
dish, you may need to create additional rows. Pro-tip: Fan
out the sliced potatoes in groups on the counter before
arranging them in the dish. Slowly pour enough of the
remaining cream mixture to barely cover the top of the
potatoes, you may not need all of the filling. Too much
filling will prevent the potatoes from crisping.

Cover the dish with foil and bake for 20 minutes. Remove
the foil and bake for an additional 20 to 25 minutes or
until the cheese is bubbling and the potato edges are
crispy. For a deeper golden brown crust, broil for a few
minutes, but watch carefully as the cheese can burn easily.

Cool for 10 minutes, serve while warm.

* Where to buy Black Garlic Salt

https://jacobsensalt.com/collections/infused-sea-
salt/products/infused-black-garlic-salt

https://www.amazon.com/Trader-Joes-Ground-
Fermented-
Garlic/dp/B08VW1MVHF/ref=sr_1_16?crid=YSF6L04
WFF81&keywords=black+garlic+salt&qid=1672718165
&sprefix=black+garlic+salt%2Caps%2C180&sr=8-16

TIPS:

Serve with a simple green salad or as a side dish for any
occasion.
If you, like me, love crispy edges, opt for a wider baking
dish with an increased surface area.

NUTRITION:

Calories: 190 Carbs: 26g Fiber: 1g
Sodium: 330mg Protein: 3g

PCLinuxOS Recipe Corner

Black Garlic Potatoes Au Gratin

https://jacobsensalt.com/collections/infused-sea-salt/products/infused-black-garlic-salt
https://www.amazon.com/Trader-Joes-Ground-Fermented-Garlic/dp/B08VW1MVHF/ref=sr_1_16?crid=YSF6L04WFF81&keywords=black+garlic+salt&qid=1672718165&sprefix=black+garlic+salt%2Caps%2C180&sr=8-16
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by kalwisti (David Pardue)

Editor’s Note: Part one of kalwisti's article
appeared in the February 2023 issue. It
continues here, with tips and themes.

PCManFM-Qt (File Manager) Tips

LXQt's default file manager, PCManFM-Qt, has
some handy capabilities which might enhance
your workflow. A split-screen feature makes it
very convenient to copy files between two
different locations.

In addition, PCManFM-Qt is able to connect to
a remote server (such as an FTP server or NAS
[Network Attached Storage]).

I described these two features in a previous
magazine article, so I will refer you to that
rather than repeating the information here.

QMPlay2

I enjoy listening to internet radio streams while I
am working on the computer. Although I usually
install VLC Media Player for this purpose, I
decided to try QMPlay2 (Qt Media Player 2)
since it came pre-installed. QMPlay2 has
impressed me; it can play all formats and

streams supported by ffmpeg and libmodplug.
Daniel has a personal connection with
QMPlay2, as he is one of the program's German
translators.

The app also has an integrated YouTube
browser.

To add a radio stream (.mp3, .aac or .ogg),
follow the steps below.

First, open QMPlay2 and click on the "Internet
radios" tab to bring it forward:

Second, click on the green " + " [plus] button to
begin adding a new station (top, right):

Third, in the pop-up dialog, paste the URL of
your desired radio station and click the "OK"
button (right):

Now, the new station will appear in the "My
radio stations" pane. To name the station and

add other ID metadata, click on the "Edit
selected radio station" button:

Type in the station's name (or call letters and
frequency) and click the "OK" button (next
page, top left):

Exploring LXQt: A Basic Guide, Part 2



PCLinuxOS Magazine Page 10

Now, close the window, select your new radio
station and click on the "Play" button.

If you want to turn off the music visualizer
(animated display), click on the "X" box in the
right corner above the graph:

Alternatively, you can accomplish this by going
to the Widgets menu on the main toolbar > and
unchecking (deselecting) "Simple
visualization." (If you decide to restore the
music visualizer later, just check (tick) this same
menu option).

Integration with radio-browser.info Database

QMPlay2 has a feature that turns it into an
excellent radio player; it incorporates the radio-
browser.info database which currently contains
more than 35,000 radio stations from around the

world. This allows users to search for radio
streams by (Radio) Name, Tag, Country,
Language or State:

In the example below, I searched for stations /
streams in the Basque language (an exotic
isolate) and retrieved several results:

When you find a station that you enjoy and wish
to save it to your Favorites list, right-click on
the station and choose "Add to my radio
stations" (top, right):

Clearing the Playlist and Grouping Stations

To clear your list of recently played stations,
from the Playlist menu > select "Clear list."

To create a custom group of related stations
(e.g., by genre, such as rock, jazz, classical),
from the Playlist menu > choose "Create
group" (or press the F7 function key).

In the screenshots below, I created a group of
Classical radio stations. First, in the Properties
pop-up window, type your desired group name
or classification term, and click on the OK
button:

Next, in your Playlist widget / panel, drag the
relevant stations into your newly created group
folder. (This screenshot shows the expanded
view of my Classical folder):

Exploring LXQt: A Basic Guide, Part 2
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FocusWriter (How to exit)

FocusWriter is designed to be a distraction-free
word processor. As such, the application opens
in full-screen mode and it was not apparent how
to exit the program. (My first instinct was to
press the Escape key, which had absolutely no
effect).

To access the drop-down menus which are
hidden away, move your cursor to the top of the
screen. Once the top toolbar appears, go to the
File menu and select Quit. Or you may simply
type the keyboard shortcut Ctrl+Q.

The F11 function key toggles between
Fullscreen mode and Minimal (smaller) mode.

Customization/Themes Basics

I should clarify that this is a bare-bones
introduction because I am not a theming guru. I
typically make only minor changes to the
default theme, then focus on using the DE.
However, for the purposes of this article, I spent
more time experimenting than usual. Although
LXQt looks nice out of the box, it looks even
better after some customization.

The realm of themes is subjective and the old
maxims, "De gustibus non est disputandum" and
"Design trends are cyclical" hold true --
regarding icon themes, flat designs versus 3D or
skeuomorphic designs, light versus dark themes,
etc. For some people, dark themes lessen eye
strain; for others, such themes cause discomfort.

Some users prefer a mix: a dark desktop
environment with a light-themed window
manager. The permutations are almost endless,
therefore I limited myself to configuring seven
different themes: three official / native LXQt
themes and four community-created themes.
Screenshots of these themes appear at the end of
the article, accompanied by a "specification
sheet" of their configuration settings. If you see
a combination that you like, you can quickly
replicate it by referring to the spec sheet.

Many of the style components that you will be
tweaking -- such as widget style, icons theme,
LXQt theme -- are found under the Preferences
menu > LXQt Settings > LXQt Configuration
Center > Appearance:

LXQt themes are either located in
/usr/share/lxqt/themes (if installed system-
wide) or ~/.local/share/lxqt/themes. (If you
install a theme locally, you will first need to
create this directory. Don't forget the initial
period before " .local"! To display hidden

files/folders in PCManFM-Qt, either type
Ctrl+H or go to its View menu > and select the
Show Hidden option).

A nice feature is that locally installed themes are
identified with the qualifier "(User Theme)" in
the LXQt Theme list display:

Exploring LXQt: A Basic Guide, Part 2

LINUX IS OUR PASSION

https://destinationlinux.org
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Window Manager

This 2022.11 Community Edition uses xfwm4
as its window manager. (Since LXQt is
windows-manager agnostic, some distros opt for
Openbox as the window manager; others use
xfwm4 as the WM. It is also possible to use
KWin -- the window manager for KDE Plasma
-- as the WM). Not only is xfwm4 available in
nearly all Linux distros, but it also has the
advantage of being a window manager and a
compositor.

Xfwm4's settings are found under the
Preferences menu > Admin > Configure Your
Computer > Configure XFWM4 Window:

Kvantum Manager

Since it can be tricky to find a theme that
matches both the Qt style and the GTK theme
style, this is where Kvantum Manager plays a

role. Kvantum is a theming engine -- a very nice
app which allows us to make the DE more
consistent with regard to theming. (However,
you must still use Xfwm4 Settings to configure
the window title bars and decorations).

Kvantum Manager is accessed via the
Preferences menu > Admin > Configure Your
Computer > Kvantum Manager. The active
theme is indicated in the bottom left corner of
its window:

To change the active Kvantum theme, click on
the Change/Delete Theme tab:

Afterwards, a list of available themes will be
displayed:

Once you have chosen a theme, click on the
"Use This Theme" button to make your selected
theme active:

To further explore a theme's settings, click on
the "Configure Active Theme" button (next
page, top left):

Exploring LXQt: A Basic Guide, Part 2

http://www.commandlinefu.com
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To watch Kvantum Manager in action, visit
Ermanno Ferrari's YouTube channel:
https://www.youtube.com/watch?v=ijmu0IDFJ4
4

EF - Linux Made Simple. "LXQt
Customization." YouTube (33 min., 16 sec.). 13
May 2020.

The segment from 18:04 -- 19:58 focuses on
Kvantum Manager. (Although he is using Arch
Linux, Kvantum behaves identically in
PCLinuxOS).

Other Considerations (Compositor)

If you own an older PC with limited resources,
you can gain some speed and reduce the load on
your graphics card by disabling visual effects
and/or compositing. These settings can be found
under the Preferences menu > Admin >

Configure Your Computer > Configure
XFWM4 Compositor. Next, click on the
Compositor tab:

One of Linux's advantages is that it is
customizable; you are not tied to how the
default desktop looks. So if you are inclined to
modify LXQt's appearance, I know that you can
find settings that please you.

More LXQt themes can be found by searching
Opendesktop.org. Creators often include brief
instructions on how to install a particular theme:

Additional Resources on Customization

LXQt Wiki. "Theming."
https://github.com/lxqt/lxqt/wiki/Theming

Satapathi, Arnab. "5 Best LXQt themes for a
better desktop experience." PCsuggest, 6 Mar.
2018. https://www.pcsuggest.com/best-lxqt-
themes/

Satapathi's installation instructions for the Lush
theme and the Notturno theme are still valid
(although for Notturno, you must first install the
git package from the PCLinuxOS repositories).

Diener, Derrick. "How to Customize the LXQt
Desktop." Addictive Tips, 21 July 2017.
https://www.addictivetips.com/ubuntu-linux-
tips/customize-the-lxqt-desktop/

Babich, Nick. "Flat vs. Material vs.
Skeuomorphic Design Examples." Adobe XD
Ideas, 24 Nov. 2020.
https://xd.adobe.com/ideas/principles/web-
design/flat-vs-material-skeuomorphic-examples/

Theme Screenshots

Official Themes

1 . Kvantum:

Widget style: kvantum
Icons theme: Papirus-Breeze
LXQt theme: Kvantum
Kvantum Manager theme: KvArcDark

Exploring LXQt: A Basic Guide, Part 2
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XFWM4 WM style: Daloa
Wallpaper: plasma-logo-dark.png
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/i87rFS6yAP
ZfF4i

2. Valendas:

Widget style: kvantum
Icons theme: Papirus-Breeze
LXQt theme: Valendas
Kvantum Manager theme: KvArcDark
XFWM4 WM style: Daloa
Wallpaper: this-is-not-windows.jpg
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/AxW5pPrC
Zn4BSrK

3. Clearlooks:

Widget style: kvantum
Icons theme: Plataro
LXQt theme: Clearlooks

Kvantum Manager theme: KvCurvesLight
XFWM4 WM style: Daloa
Wallpaper: cloud.png
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/WsycCmCcs
yrgA5w

Community Themes (Installed Locally)

4. Lush:

Widget style: kvantum
Icons theme: Papirus-Green
LXQt theme: Lush-lxqt-theme-0.1
Kvantum Manager theme: KvCurvesLight

XFWM4 WM style: Daloa
Wallpaper: drop.png
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/DD5cEZwS
7crR5xt

5. Notturno:

Widget style: kvantum
Icons theme: Papirus-Blue
LXQt theme: Notturno
Kvantum Manager theme: KvArcDark
XFWM4 WM style: Daloa
Wallpaper: plasma-logo-dark.png
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/4H6mLLJ8k
RZMENi

6. MGLinux:

Widget style: Fusion
Icons theme: Oxygen
LXQt theme: MGLinux

Exploring LXQt: A Basic Guide, Part 2
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Kvantum Manager theme: KvCurvesLight
XFWM4 WM style: Daloa
Wallpaper: waves-logo.png
(Stock wallpaper from
/usr/share/lxqt/wallpapers)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/XfdbcXj37k
QeGx8

7. EXperience (for nostalgia's sake with a
smidgen ofWindows XP humor):

Widget style: Windows
Icons theme: YlmfOS
LXQt theme: EXperience
Kvantum Manager theme: KvCurvesLight
XFWM4 WM style: Daloa

Wallpaper: Bliss_1920x1080.png
(Downloaded from the Google Drive link in this
Reddit thread)
Link to full-resolution screenshot:
https://pcloscloud.com/index.php/s/tKGHEFg8
QkdnHDr

Exploring LXQt: A Basic Guide, Part 2
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by Corynne McSherry
Reprint from Electronic Frontier Foundation
Under Creative Commons Attribution License

Lawyers, scholars, and activists, including EFF,
often highlight Section 512 of the Digital
Millennium Copyright Act and Section 230
(originally of the Communications Decency
Act) as the legal foundations of the internet. But
there’s another, much older, doctrine that’s at
least as important: Fair use, which dates back
many decades and is codified in law as Section
107 of the Copyright Act. Fair use is, in essence,
the right of the public to use a copyrighted work

in a variety of circumstances, without the
rightsholder’s permission. It’s why a reviewer
can quote from the book they’re reviewing, a
parody video can include excerpts from a
movie, and security researchers can copy a
software program in order to test it for malware.

Fair use is essential to the internet for at least
two reasons. First, the vast majority of what we
do online, from email to texting to viewing
images and making TikToks, involves creating,
replicating, and/or repurposing copyrighted
works. Since copyright is a limited but lengthy
monopoly over those works, in theory, using or

even viewing them might require a license; now,
and for many decades in the future.

Second, technological innovation rarely means
starting from scratch. Instead, developers build
on existing technologies, hopefully improving
them. But if the technology in question involves
code, it is likely copyrightable. If so, that add-on
innovation might require a license from the
rightsholder, giving them a veto right on
technological development.

As digital technologies dramatically (and
sometime controversially) expand the reach of

Fair Use Creep Is A Feature, Not A Bug

https://www.eff.org/about/staff/corynne-mcsherry
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https://www.eff.org/issues/cda230
https://www.eff.org/issues/intellectual-property
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copyright, fair use helps ensure that the rights of
the public expand as well.

Examples abound. In 2021, for example, the
Supreme Court held that Google’s use of certain
Java Application Programming Interfaces
(APIs) was a lawful fair use. While we argued
that the API’s weren’t copyrightable in the first
place, the decision gave more legal certainty to
software developers’ common practice of using,
reusing, and re-implementing software
interfaces written by others, a custom that
underlies most of the internet and personal
computing technologies we use every day. Or
consider Authors’ Guild v. Hathitrust, where the
Second Circuit Court of Appeals held that fair
use sheltered book digitization. Contrary to the
complaints of rightsholders, neither decision has
discouraged investment in new creativity.

Today, fair use is helping to defend the efforts of
public interest organizations to share culture,
ideas, and knowledge in ways that would never
have been possible without the internet. In one
case, at stake is the ability of librarians to make
decisions about how to curate and lend the
books in their collections. In another, at stake is
access to the law.

In Hachette v. Internet Archive, four of the
biggest publishers in the world, are trying to
shut down Controlled Digital Lending, which
allows people to check out digital copies of
books for two weeks or less and only permits
patrons to check out as many copies as the
Archive and its partner libraries physically own.
That means that if the Archive and its partner

libraries have only one copy of a book, then
only one patron can borrow it at a time.

Supported by authors, libraries, and scholars,
the Internet Archive has explained that CDL is a
lawful fair use that serves copyright’s ultimate
purpose: enriching our common culture.
Through CDL, the Internet Archive is fostering
research and learning by helping its patrons
access books and by keeping books in
circulation when their publishers have lost
interest in them. Digital lending also allows
patrons to borrow books without having their
reading habits tracked by commercial entities,
like OverDrive and Amazon, that may not share
librarians’ traditional commitment to protecting
privacy. Perhaps most importantly, it gives
librarians the power to curate their own digital
collections, just as they curate their physical
collections. If the publishers have their way,
however, books, like an increasing amount of
other copyrighted works, will only be rented,
never owned, available subject to the publishers’
whim.

In ASTM et al v. Public.Resource.Org, three
huge industry associations are trying to prevent
a tiny nonprofit, Public.Resource.Org, from
posting online standards, such as building codes,
that have been made into laws. Our laws belong
to all of us, and we should be able to find, read,
and comment on them free of registration
requirements, fees, and other roadblocks. The
industry associations insist that because they
helped shepherd the volunteers who actually
develop those standards, they own and can
control access to those laws. As Public Resource

explained to a federal appeals court last year,
even assuming the standards can be subject to
copyright at all, posting them online, for free, to
facilitate research and comment, is a
quintessential fair use. A lower court has already
reached that conclusion, and we expect the
appeals court will agree.

The lawsuits are ongoing, but these projects,
and the benefits they create, might not exist at
all if these nonprofits couldn’t rely on the fair
use doctrine.

But even where a use is clearly lawful and fair,
efforts to invoke it can be stymied by practical,
technical, and legal barriers. Defending fair uses
can be expensive. As Professor Larry Lessig
once said, “Fair use is the right to hire a lawyer”
– and many of us don’t have the resources to do
that, nor access to pro bono counsel. What's
worse is rightsholders often rely on a
combination of contracts, technical measures,
and legal constraints to prevent or inhibit fair
uses. In the gaming space, for example, vendors
require users to agree to contracts that forbid
them from using add-on services, and do not
hesitate to sue third parties who try to provide
those services. They put digital locks on games
to prevent efforts to remix or even just preserve
games for posterity. And if anyone breaks those
digital locks, even for otherwise lawful reason,
they may face a legal claim under Section 1201
of the DMCA.

But this problem goes far beyond traditional
creative industries. Manufacturers of everything
from medical devices to tractors use the same

Fair Use Creep Is A Feature, Not A Bug
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tactics to prevent independent repair and
competitive innovation that are otherwise
protected fair uses.

As technology creeps into every facet of our
lives, right holders will continue to look to
copyright to jealously guard their legacy
position as gatekeepers. Fortunately for the
public, fair use has likewise grown to protect the
original purpose of copyright: to encourage
forward progress. And no matter what
Hollywood or John Deere tells you, that’s a
feature, not a bug.
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by Paul Arnote (parnote)

Back in November 2022, there was a thread in the PCLinuxOS forum
where GOTHBITES was asking how to view a JXL (JPEG XL) file. Back
in April 2022, the JXL format was talked about in an article on WEBP
graphics. PCLinuxOS users … heck, most users, regardless of the
operating system … are pretty much up a creek without a paddle when it
comes to viewing or using JXL files. I’m doubtful that the JXL format will
gain much traction, performing like most of the JPEG Group’s other
attempted modifications to the original JPG format. And none of them
resulted in anything resembling widespread use, except among the
committee members and their fanbois.

By the second page of the aforementioned forum thread, talk had turned to
the “newish” WEBP graphic format (originally announced by Google in
September 2010 as an open source format, but the first stable version of its
library didn’t come out until April 2018, according to Wikipedia) that
appears to be coming on strong with widespread adoption, at least on the
web. I’ve even seen “reports” that the Google Chrome web browser will
save images in the WEBP format when/if you select “Save Image…” from
an image on a web page. However, none of the usual word processors or
publishing programs known and used by Linux users (including
LibreOffice and Scribus) recognize the WEBP graphics format, but all of
the major web browsers and GIMP support the format.

As a result, users are encountering WEBP graphic files at an ever
increasing rate. In short, the huge benefit to WEBP graphic files is their
smaller file size and excellent image quality means web designers can use
smaller files, which helps webpages load and display faster. Whenever
those users find a WEBP graphic and want to use that graphic in a
LibreOffice creation or in a publishing program, that WEBP graphic has to
be converted to either a PNG or JPG file (typically) that the importing
program recognizes.

Now rewind 10 years, to March 2013. Then, I published a custom Zenity-
enhanced bash script in my Xfce Power User Tips, Tricks & Tweaks:
Working With Graphics article. I still use that bash script, albeit slightly
enhanced, attached to a Thunar Custom Action today … A LOT. That
forum thread lit a fire under me to further enhance the script I originally
published 10 years ago.

So, below is the newly enhanced version of that script. To keep the line
numbers in proper order, the script is presented as a graphic. You can
download the script from the magazine website. When/if you do so, store
the bash file wherever you typically store your bash files (preferably
somewhere within your path), strip the “.txt” file extension from the
downloaded file, and make the file executable.

Converting Between Graphics Formats, Revisited
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The first 10 lines of the script create the Zenity dialog box below
(specifically, line 5), asking the user to choose a graphics file format to
convert the original graphic to. I have altered the original script to prevent
accidentally overwriting your original files. In previous iterations of this
script, if you entered the same file extension for the output file as the input
file, and you were saving that file in the current directory (./), you risked
overwriting your original file. Such an overwrite of your original graphic
file(s) has the potential to be disastrous. Of course, if the image is already
in the format you desire, there’s little other reason for you to be using this
script, anyways. But, mistakes can and do happen, so I’ve taken steps to
mitigate this particular disastrous outcome. Another thing you could do
would be to specify a new directory (in the third dialog box of this script)
to place all of your output files into. But, my solution should completely
eliminate the possibility of your original files ever being overwritten.

You can choose between JPG, PNG, WEBP, AVIF, TIFF, BMP or GIF file
formats for the output file. The last two were added in a flight of fancy,
and I suspect not too many users will want to use either on a regular basis.
It would be trivial to add (or remove) file formats to this command in line
5 (hint: they are listed near the end of that command). If you choose to add
additional graphic file formats to the script, just be sure that they are

formats that ImageMagick recognizes (since it’s what does the heavy
lifting in this script).

Lines 9 and 10, holdovers from the original script where users had to enter
the file format manually, ensure that the file extension is in lowercase text.

In the next dialog box (represented by lines 12-15 in the script), enter the
number representing the percentage of quality level for the output file. You
can enter any number between 1 and 100. Just keep in mind that larger
numbers represent less compression (thus, a larger output file size and

Linux Training
Courses & Classes

Converting Between Graphics Formats, Revisited
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higher image quality), while smaller numbers represent greater
compression (thus, a smaller output file size and lower image quality).

I’ve also added in some “error checking” with this version of the script, in
lines 16-19. The number you enter MUST be between 1 and 100. If it is
not, a Zenity error dialog appears, as shown below, and the script exits.
The script also displays the error message and exits if you hit the “Enter”
key without any input, or if you enter letters instead of numbers, or a
mixture of letters and numbers.

The third (main) dialog box (represented by lines 30-36) is where you
specify the directory for the output file. You can enter “./” as the output

directory (meaning the same directory as the input file). Or, you can
specify a different directory. If the directory you specify doesn’t already
exist, it will be created for you.

Lines 38-47 set up a loop that processes each file (yes, you can enter
multiple files or use wildcards) with the ImageMagick convert command
(line 44). It’s in this line of the script where the valid value you entered for
the quality level is appended to the end of the input filename, preventing
the overwriting of your original file(s).

Finally, line 49 displays a progress dialog box for visual feedback for the
user about where in the process the script is for converting the graphic
files, before exiting cleanly when all tasks are completed in line 51.

Converting Between Graphics Formats, Revisited
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As with most of my scripts, it is intended to be run either as a standalone
bash script from the command line, or (in my case, and in the case of other
Xfce users) as a Custom Action from within Thunar. If you are “new” to
Xfce and need assistance in setting up the Custom Action in Thunar,
review my original article from March 2013. There, I show step-by-step
how to create the Custom Action for this script. Mate and KDE users
should also have very little trouble adapting this to either Caja or Dolphin
file managers in a similar manner, but I’m not the one to direct that
endeavor, since I really never use those desktops. I’m sorry LXQt users,
but PCFileMan is a different animal altogether.

Summary

This article isn’t a deep, detailed look at the WEBP graphics format. For
that, reread my previous article from 11 months ago, where I dive deeply
into it. It is a good output format that offers very good image quality with
great savings in file size.

However, it’s going to take time for the LibreOffice and Scribus
developers … and many others … to catch up. For example, my favorite
image viewer is GPicView, because it’s so small and fast. It is incapable
(at this time) of viewing WEBP images.

I have not tested the script with JXL files (why would I even have these
files littering up the place when there’s so little support for them in the first
place?), but it should also work to convert from that format. Basically, if
ImageMagick “understands” the input graphic file format, the script
should be able to convert it to a more common graphic file format that you
can use.

So, for those times when you need to convert between graphic file formats,
I give you this bash file to more easily facilitate the conversion of WEBP
graphic files to a format that you can use with those programs. Are there
other ways to get the “job” done? Certainly. But this script is simple and
easy, and most of all, reliable.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!

Converting Between Graphics Formats, Revisited

http://pclosmag.com/special.html
https://pclosmag.com/html/Issues/201303/page09.html


PCLinuxOS Magazine Page 23

by Davecs
from The PCLinuxOS Forum

Do you ever look up from your keyboard to the
screen, only to see that you've typed everything
in CAPS, and you have to delete and retype it?
You'd pressed the CAPS key in error. It
happens.

Now in the Xfce Settings Manager >
Keyboard > Layout, it's possible to reassign
CAPS LOCK to Compose, meaning that the
worst that can happen if you accidentally hit the
CAPS key is that one character has to be

replaced by 2 or 3. However, if you do that,
there may be times when you actually require
CAPS to be LOCKed. One example here in
Britain is when you get a loyalty voucher from a
well-known supermarket chain, and to claim it,
you have to enter a long string of characters
consisting of numbers and capital letters, and
you don't want to keep alternating the SHIFT
key as you type. Lower case letters result in an
error. It is possible to set CAPS LOCK by
pressing both SHIFT keys via the KDE Control
Centre, but not Xfce.

As a sort of extra, there is a redundant light on
most keyboards, the SCROLL LOCK indicator.
If you have more than one language/layout
setting on your keyboard, the Xfce Settings
Manager>Keyboard>Layout, enables you to use
a key (e.g. Scroll Lock) to switch between
layouts, but does not allow you to toggle the
indicator on the keyboard. This feature is
enabled in the KDE Control Centre, but not in
Xfce.

Well, here is a short script which will enable
you to set CAPS LOCK by pressing both SHIFT
keys together, and turning it off by pressing a
single SHIFT key. It will also enable the
SCROLL LOCK lamp to come on when you
switch to your secondary keyboard layout. I've
called it "keyboard-extras" and put it in the
folder /usr/local/bin/. It has to be saved as root
and made executable.

#! /bin/bash

#wait a while to let original setup
finish first,
#on a slow computer you might need
to give it more time
#otherwise the changes made in this
script will be overwritten
#and ineffective

sleep 10

#this line adds the option for two
shift keys together to set
#CAPS LOCK, and one of them alone
to cancel it.

setxkbmap -option
"shift: both_capslock_cancel"

#this line causes the SCROLL LOCK
lamp to come on when you
#switch to your secondary keyboard
layout.

setxkbmap -option "grp_led: scroll"

#other lines as necessary

Now all you have to do is add a new item to
Xfce Settings Manager > Session and Startup as
follows (next page, top left):

Tip Top Tips: Xfce Configuration For The CAPS-LOCK
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Name: Keyboard Extras
Description: Add extra features to keyboard
Command: /usr/local/bin/keyboard-extras
Trigger: on login

And you will have these extra features when
you next log in!
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by Meemaw

I’ve been on YouTube again, looking for extra
knowledge about GIMP. As I’ve said before,
one of my faves is Davies Media Design. He
outlined ten time-saving tips, which are mostly
keyboard shortcuts, but they are really good, so
I’ ll share. Some of them have two tips in the
same section, so you’ ll end up with more than
ten.

1. Opening a new project - Pressing <CTRL>
+ N, then <Enter> quickly opens a new project
using the last size & configuration you chose.
Also, <CTRL> + 1 opens the last project you
had open, <CTRL> + 2 opens the one before
that, and so on…

2. Create guides easily using the Guides
menu. <CTRL> + A selects all, then Image >
Guides > New Guides opens a window where
you can enter the location of your guide and
which direction it needs to be. You can do this
by percent or by measurement (there are two
menu items - one says New Guides by percent).
If you have something selected, you can do New
Guides from selection, which will put guides
around the borders of your selection. Below, I
have added a horizontal guide to my blank
project, and have opened it again to add a
vertical one. My width was 1024 px so adding
the guide at 512 px will make it centered
(center, top).

3. You can open multiple images at the same
time. All you have to do is select the ones you
want to open and then drag them into the square
at the top of the tools menu (where the GIMP
mascot is), and all images will open in separate
tabs. Also, if for some reason you want to open
them all in the same project, drag them to the
window where you do your work, and there will
be one tab with each image on its own layer.

4. <CTRL> + F performs the last action you
have done. On one of my photos, I used Levels
to bring out the color of the vegetation. I
thought that the same settings would work on
one of the other photos, so I switched to it and
pressed <CTRL> + F. Every photo is different,
so that doesn’t always work, but this time it
worked pretty well for me. To bring up the last
tool used (in my case it was Levels), press
<CTRL> + <SHIFT> + F, and the tool’s
window will appear, and you can adjust it from
there.

5. You can use the colors menu to change a
layer mask. I know, layer masks are confusing,
but if you have done one, you can change the
effect. Years ago, I did a layer mask on an image
of a flower for a different effect.

If I decide I want it to have the leaves colored
and the flowers gray, I select the layer mask
(that white square next to the upper layer), then

GIMP Tutorial: Time-Saving Tips

https://www.youtube.com/@DaviesMediaDesign
https://www.youtube.com/watch?v=qXHklhqq62k
https://pclosmag.com/html/Issues/201210/page08.html
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choose Colors > Invert.

I don’t like that - I like the red flowers, so I’ ll
press <CTRL> + Z to undo the color invert.

6. Adding a folder location - If you put several
things in one folder and don’t want to have to
keep finding it, you can add the folder location
to your save window. I’m working on several
photos I want to save in the same spot. When I
export the first one, I can add that folder to my
export window. When you navigate to the folder
you want to save, select it, then click the little
plus sign at the bottom left of the folder window
(center, top).

Alternatively, if you have a folder you use a lot,
you can go into GIMP Preferences, and add the
folder location there (in the section called
Folders).

7. Find where you originally got your image.
If you haven’t saved that folder to your
shortcuts yet, and can’t remember where you

got that image, press File > Show in File
Manager, and your file manager (Thunar,
Dolphin, whatever you use) will open to the
folder your image came from.

8. Move tool settings - The move tool has two
different modes - pick a layer or guide, which
means you have to select the layer or item you
want to move. What if you have several stacked
levels? Do you want to move something on the
5th level down and can’t get hold of it? Change
your Move mode to Move the active layer and
make sure the correct level is chosen, and move
your item (top, right).

9. Bring any layer to the top immediately -
Press <Shift> + Up Arrow and your chosen
layer will move instantly to the top. This works
particularly well if your project has several
layers.

10. Use the search action in Help to find any
filter. Help > Search and run command can
find that elusive filter in the location you forgot.
For some reason, I need to generate a coffee
stain on my drawing, but I can’t remember
where it is, so I’ ll choose that help item.

GIMP Tutorial: Time-Saving Tips
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If you already know all of these tips, you’re
ahead of me! If not, I hope you learned some
useful information!

Screenshot ShowcaseScreenshot Showcase
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GIMP Tutorial: Time-Saving Tips

Posted by luikki, on February 17, 2023, running KDE.
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Serves 4

INGREDIENTS:

3 tbsp unsalted butter
4 garlic cloves, diced
2 Serrano (or jalapeno peppers),

chopped into thin rings
¾ cup half and half
1 cup extra sharp yellow cheddar cheese,

plus more for the top
1 cup extra sharp white cheddar cheese,

plus more for the top
2 tsp of Jacobsen Salt Co. Tingly Sichuan Salt.
1 tsp freshly cracked Peppercorns
1 tbsp chives, thinly sliced
1 lb uncooked pasta shells (or elbow, penne, or
rigatoni pasta but common shells are the best)

1 tbsp salt
½ cup breadcrumbs
½ cup grated Parmesan cheese

DIRECTIONS:

Preheat your oven to 350F.

In a large saucepan, melt your butter over
medium heat and cook your garlic until it turns
translucent before adding your serrano peppers
and cooking for an additional three minutes.
Meanwhile, on the neighboring burner, bring a
large pot of water to a boil and add salt into the
water.

Lowering the heat under the pan to medium-
low, pour your half and half into the pan and stir
with a wooden spoon. Start to sprinkle in your
cheeses one handful at a time while whisking
each handful until it's fully incorporated into the
sauce and season the cheesy mixture with
Tingly Sichuan Salt and chives.

By this time, your water should be at a rolling
boil, keeping your cheese sauce in the corner of
your eye and continuing to stir so it doesn't
stiffen or form a skin over its surface, cook your

pasta and drain. Add your pasta shells to the
saucepan with your cheesy sauce and stir with a
wooden spoon until each noodle is completely
coated in cheese.

Spoon your pasta into a baking dish or oven-
safe cast iron skillet, get every drop of sauce
over your shells. Top the baking dish or pan
with breadcrumbs and remaining cheese and
bake for 20 minutes or until the breadcrumbs
turn a light golden brown. Remove from the
oven and allow to cool for at least five minutes
before serving.

NUTRITION:

Calories: 530 Sodium: 550mg Carbs: 51g
Fiber: 1g Protein: 23g

PCLinuxOS Recipe Corner Bonus

Spicy Mac 'N Cheese

http://www.linuxforums.org/forum/
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by Alessandro Ebersol (Agent Smith)

Folks, where has the world gone? After all that
we have been going through in the last few
years, we are now having a wave of UFO
sightings. Yes, unidentified objects are popping
up everywhere, and if they are just Chinese
balloons, we are fine. BUT what if they are not?
If the aliens are really visiting us and preparing
an invasion ?

Well, to prepare for the aliens' arrival, nothing
better than playing X-Com: UFO Defense, a
strategy game by Microprose, released in 1994.

Aliens Attack!

X -COM: UFO Defense (known as UFO:
Enemy Unknown in Europe) is a 1994 science
fiction strategy video game developed by
Mythos Games. It was published by MicroProse

for DOS and Amiga computers, the Amiga
CD32 console, and the PlayStation.

Originally planned by Julian Gollop as a sequel
to 1988's Laser Squad, the game mixes real-time
management simulation with turn-based tactics.
The player assumes the role of the commander
of X-COM - an international paramilitary
organization that secretly defends Earth from an
alien invasion. Throughout the game, the player
is tasked with issuing orders to individual X-
COM troops in a series of turn-based tactical
missions. On a strategic scale, the player directs
research and development of new technologies,
builds and expands X-COM bases, manages the
organization's finances and personnel, and
monitors and responds to UFO activity.

The game received strong reviews and achieved
commercial success, acquiring a cult following
among strategy fans; several publications listed

X-COM: UFO Defense as one of the best video
games ever made, including IGN ranking it as
the best PC game of all time in 2007. It was the
first and best entry in the X-COM series and
directly inspired several similar games,
including UFO: Alien Invasion, UFO:
Extraterrestrials and Xenonauts. An official
remake of the game, X-COM: Enemy
Unknown, was created by Firaxis Games and
published by 2K Games in 2012. Mythos
Games' and Julian Gollop's own original
spiritual successor project, The Dreamland
Chronicles: Freedom Ridge, was canceled in
2001 and then partially transformed into UFO:
Aftermath by another developer. Gollop's new
X-COM project, Phoenix Point, was released in
2019.

The story of X-Com : UFO Defense, for those
who don't know...

Game Zone: X-Com: UFO Defense
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The story of X-COM, set in the near future, at
the time of the game's release, begins in the year
1998. The initial plot centers on increasing
reports of UFO sightings, as reports of
abductions and rumors of attacks by mysterious
aliens become widespread, much the way it is
happening now... Is life imitating fiction ?

The nations of the world come to perceive this
as a threat, and try to form their own forces -
such as Japan's Kiryu-Kai force - to deal with
the crisis, but these efforts are not successful.
On December 11, 1998, representatives of some
of the world's most powerful nations met
secretly in Geneva to discuss the issue. From
this meeting is born the clandestine defense and
research organization Extraterrestrial Combat
(X-COM), over which the player takes control
at the beginning of the game.

At first, the player will only have access to
conventional weapons, but as the game
progresses, the player learns more about the
enemy, their species, mutant creations, and
technology. In the end, it is revealed that the
"leaders" behind the alien invasion are a race
known as Ethereals who possess powerful mind-
control abilities and enslave other alien races to
carry out their plans, and that their main base in
the Solar System is located in the Cydonia
region on Mars. The player must then prepare
the final assault team, attack Cydonia, and
destroy the mastermind behind the alien
invasion, the Alien Brain biocomputer.

The game can end in several ways. If the
player's performance is poor or worse for two

consecutive months, the player runs a deep
deficit for two consecutive months, all the
player's bases are captured, or the player mounts
an assault on the alien Mars base and loses, the
game ends in defeat, where in the PlayStation
version, the nations funding council makes a
futile attempt to negotiate with the aliens, who
violently murder the negotiator. While in the
MS-DOS version, the funding nations sign pacts
with the aliens promising peace, but instead
destroy every city and poison the water and air
to destroy any resistance, the remaining
survivors are placed in slave camps to help
terraform Earth for future alien colonization. If,
however, the player is victorious in the final
attack, the game ends with the victory of
humanity.

Gameplay

Well, I am a huge fan of this game, and when I
saw that there was a community made version, I
wasted no time in bringing it to our repositories.

I used to stay up all night defending the earth
against the aliens, and it was a great game. As
described above, it has two phases: A
managerial strategy phase, where the player
manages the X-Com bases around the world,
and, because of this, many factors must be taken
into consideration: where to establish the bases,
how many quarters to make per base, how many
scientists to hire, how many soldiers to recruit.
And, of course, always invest in better
equipment, both for the soldiers and for the
bases, which have aircraft capable of shooting
down attacking UFOs.

The difficulty goes from very easy to the super
human level. At this level, the aliens are
invincible and attack incessantly. It is quite a
challenge.

Its second phase is turn-based combat, like a
good war game, where the player must lead his
squadron to the wreckage of downed alien ships,
or, in more advanced levels, alien bases on
earth, and, in the end, on Mars.

It is necessary to be very careful with your
squadrons, as your soldiers are upgraded
throughout the game, and losing them is costly,
as they cannot be resurrected. Dead soldiers
must be replaced by new recruits with minimal
skills.

Of course, playing for so long, you eventually
get tired of it and get a stat editor for your
soldiers, increasing their powers much faster
than playing normally, but it is a way to balance
the game's relentless AI.

Game Zone: X-Com: UFO Defense
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How to play on PCLinuxOS

To play Openxcom on PCLinuxOS, you must
have a copy of the original DOS game, X-COM:
UFO Defense.

Install openxcom, via terminal or Synaptic.

Run the program for the first time, it will create
an .openxcom folder in your /home directory.
Note the “.” at the beginning of the folder name.
This will make it a hidden directory on your
computer.

From there you should copy any X-com game
you have into a subfolder inside the .openxcom
folder.

For the first game, you should have a subfolder
called UFO, in capital letters. For the second
game, a folder called TFTD, in uppercase as
well. In these folders, as described above, the
respective games should be copied.

After that, just click on openxcom in the
program menu and start the battle against the
aliens!

So, a game that mixes 50's fiction movies with
managerial strategy, it's not every day that it
appears.

I hope you enjoyed it, and happy gaming!

P.S. If you don’t have the original games, they
can be bought cheap from GOG

https://www.gog.com/en/game/xcom_ufo_defen
se

https://www.gog.com/en/game/xcom_terror_fro
m_the_deep

Screenshot ShowcaseScreenshot Showcase

Game Zone: X-Com: UFO Defense

Posted by francesco_bat, on February 10, 2023, running Trinity.
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
a
d
P
u
z
z
le
S
o
lu
ti
o
n
s
H
e
re

Possible score 237, average score 166.

PCLinuxOS Puzzled Partitions

https://pclosmag.com/html/Issues/202303/files/2023-03-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/


PCLinuxOS Magazine Page 33

AIRPOLLUTION ANEMOMETER

CUMULONIMBUS CYCLONE

DOLDRUMS EVAPORATION

FLASH FLOOD FREEZING RAIN

FUNNEL CLOUD GRAUPEL

GREENHOUSE EFFECT HABOOB

HYDROMETER MAMMATUS CLOUD

METEOROLOGIST MONSOON

NIMBOSTRATUS PARHELION

ROPE TORNADO SANDSTORM

SNOWSQUALL SQUALL LINE

ST ELMOS FIRE STATIONARY FRONT

STRATOCUMULUS TEMPERATURE

TORNADO ALLEY TROPOSPHERE

TYPHOON VAPOR TRAIL

WEDGE WESTERLIES

ATMOSPHERIC PRESSURE

BAROMETRIC PRESSURE

BEAUFORTWIND SCALE

CONDENSATION

Download Puzzle Solutions Here
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1. An instrument for measuring the force or velocity

of the wind.

2. A physical scientist who observes, studies, or

forecasts the weather.

3. A column of cloud-filled wind rotating over a body

of water.

4. Also known as snow pellets, soft hail, small hail,

tapioca snow, rimed snow, it is a mix of snow

& hail.

5. An atmospheric optical phenomenon that consists

of a bright spot to one or both sides of the Sun.

6. Dust storms caused by strong winds flowing

downward and outward from thunderstorms.

7. A group of thunderstorms arranged in the form of a

long line, often hundreds of miles long, but only

between 10 to 20 miles wide.

8. Dark, grey, featureless layers of cloud, thick

enough to block out the sun and produce persistent

rain.

9. One of the first scales to estimate wind speeds and

their effects on a scale from 1 to 12.

10. A persistent blue glow that occasionally appears

near pointy objects during storms.

11. A measure of the rate of heat loss from skin that is

exposed to the air which uses the temperature and

wind speed.

12. A tornado, with a funnel at least as wide at the

ground as it is tall.

13. An intense circular storm that originates over

warm tropical oceans and is characterized by low

atmospheric pressure, high winds, and heavy rain.

14. A cellular pattern of pouches hanging underneath

the base of a cloud,

15. Large clouds with dark bases and tall billowing

towers.
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Posted by dpascal, on February 19, 2023, running Mate.

Posted by brisvegas, on February 3, 2023, running Mate.

Posted by The_CrankyZombie, on February 1 , 2023, running KDE.

Posted by bones113, on February 19, 2023, running Xfce.
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